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Dell™ Personal All-In-One Printer A920

Owner’s Manual
Look Inside For:
• Learning about your printer

• Understanding the software

• Maintenance and Troubleshooting



i i

Order ink cartridges

Dell™ ink cartridges are available only through Dell. You can order ink 
cartridges online at www.dell.com/supplies or by phone.

USA 877-465-2968
(877-Ink2You)

Canada 877-501-4803

Mexico 001-800-210-7607

Puerto Rico 800-805-7545

UK 0870 907 4574

Ireland 1850 707 407

France 0825387247

Italy 800602705

Spain 902120385

Germany 0800 2873355

Austria 08 20 - 24 05 30 35

Netherlands 020 - 674 4881

Belgium 02.713 1590

Sweden 08 587 705 81

Norway 231622 64

Denmark 3287 5215

Finland 09 2533 1411

Switzerland 0848 801 888



Understanding the printer 

# Use the: When you want to:

1 Paper guide Ensure proper paper feeding.

2 Paper support Load paper into the printer.

3 Operator panel Operate the printer.

4 Paper exit tray Hold paper as it exits the printer.

5 Printer (scanner unit) Access the ink cartridges.

6 Top cover Place an item on the scanner glass.

2
3

5

6

1

4

9

7

8
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7 USB cable connector Insert the USB cable.

8 Power supply Supply power to the printer. 
NOTE: Place the metal contacts to the left.

9 USB cable (sold 
separately)

Connect the printer to your computer.

# Use the: When you want to:



Notes, Notices, and Cautions
 NOTE: A NOTE indicates important information that helps you make better 
use of your printer.

 NOTICE: A NOTICE indicates either potential damage to hardware or loss of 
data and tells you how to avoid the problem.

 CAUTION: A CAUTION indicates a potential for property damage, 
personal, injury, or death.

____________________ 

Information in this document is subject to change without notice. 
© 2003 Dell Computer Corporation. All rights reserved. 

Reproduction in any manner whatsoever without the written permission of 
Dell Computer Corporation is strictly forbidden.

Trademarks used in this text: Dell and DELL logo are trademarks of Dell 
Computer Corporation; Microsoft and Windows are registered trademarks of 
Microsoft Corporation. 

Other trademarks and trade names may be used in this document to refer to 
either the entities claiming the marks and names of their products. Dell 
Computer Corporation disclaims any proprietary interest in trademarks and 
trade names other than its own.

____________________ 

UNITED STATES GOVERNMENT RESTRICTED RIGHTS
This software and documentation are provided with RESTRICTED 
RIGHTS. Use, duplication or disclosure by the Government is subject to 
restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical 
Data and Computer Software clause at DFARS 252.227-7013 and in 
applicable FAR provisions: Dell Computer Corporation, One Dell Way, 
Round Rock, Texas, 78682, USA.



 Caution: SAFETY INFORMATION
Use the following safety guidelines to help ensure your own personal safety 
and to help protect your computer and working environment from potential 
damage.

• Use only the power supply provided with this product or the 
manufacturer’s authorized replacement power supply.

• Connect the power cord to an electrical outlet that is near the 
product and easily accessible.

• Refer service or repairs, other than those described in the user 
documentation, to a professional service person.

 CAUTION: Do not use the fax feature during a lightning storm. Do 
not set up this product or make any electrical or cabling 
connections, such as the power supply cord or telephone, during a 
lightning storm.
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 Setting up the printer
If you have not already done so, follow the steps on the Placemat (poster) to complete the 
hardware and software installation. If problems occur during the setup process, see Setup 
troubleshooting on page 34.

Using the operator panel
The printer has an operator panel that lets you scan and copy with the press of a button.

 NOTE: Both the computer and the printer must be turned on to make copies.

# Press: To:

1 Power Turn the printer on and off.

2 Scan Start the scanning process and to open the Dell All-In-One Center.

3 Black Copy Make a black and white copy.

4 Color Copy Make a color copy.

5 Paper Feed Feed paper through the printer.

1

2

3

5

4

2 Learning about your printer
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 The printer software includes the:

• Dell All-In-One Center—helps you perform various scan and copy operations and 
manage your saved images.

• Print Properties—helps you adjust print settings.

• Dell Image Expert—helps you edit your photos.

• Dell Printer Solution Center—provides maintenance and troubleshooting help, as well 
as cartridge ordering information.

Accessing the Dell All-In-One Center
To access the Dell All-In-One Center, click Start → Programs → Dell Printers → Dell 
AIO Printer A920 → Dell All-In-One Center.

The All-In-One Main page appears.

The All-In-One Main page
The All-In-One Main page consists of four main sections. The following table describes 
each of the sections.

From this section: You can:

Scan • Select a program to send the scanned image to.
• Choose what type of image is being scanned.
• Choose how the scan will be used.
NOTE: Click See More Scan Settings to view all settings.
4 Understanding the sof tware



 NOTE: For more information about the All-In-One Main page, View Saved Images page, or the 
Maintain/Troubleshoot page, click the Help button located in the upper right corner of the 
screen.

View Saved Images page
Use the View Saved Images page (accessed from the All-In-One Main page) to perform 
tasks with images that are saved on the computer. The View Saved Images page consists of 
three sections.

Copy • Select the quantity and color of your copies.
• Select a quality setting for your copies.
• Adjust the size of the scanned area.
• Lighten or darken your copies.
• Enlarge or reduce your copies.
NOTE: Click See More Copy Settings to view all settings.

Creative Tasks Choose from a variety of creative ideas.
• Enlarge or reduce an image.
• Repeat an image several times on one page.
• Print an image as a multi-page poster.
• E-mail an image to a friend.
• Fax using your computer’s modem.
• Save an image on your computer.
• Edit text found in a scanned document (OCR).
• Modify an image with a photo editor.

Preview section • Select a region of the preview image to scan.
• View an image of what will be printed or copied.

From this section: You can:

Open with... Select a program to send the saved image to.

Print a Copy... • Choose the quantity and color of your copies.
• Select a quality setting for your copies.
• Lighten or darken your copies.
• Enlarge or reduce your copies.
NOTE: Click See More Copy Settings to view all settings.

From this section: You can:
Understanding the sof tware 5
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Maintain/Troubleshoot page
The Maintain/Troubleshoot page (accessed from the All-In-One Main page) provides you 
with direct links to the Dell Printer Solution Center. Choose from these topics:

• Maintain or fix quality problems

• Troubleshoot All-In-One problems

• Device status and ink levels

• More printing ideas and how to’s

• Contact information

• Advanced

• View the software version and copyright information

For more information about the Dell Printer Solution Center, see page 8.

Accessing Print Properties
You can change your printer settings in Print Properties. To open Print Properties:

1 With your document open, click File → Print.

The Print dialog box appears.

2 In the Print dialog box, click Properties, Preferences, Options, or Setup (depending 
on your program or operating system).

Creative Tasks Select from a variety of creative ideas. For a list of creative tasks available 
from the All-In-One Main page, see page 5.

From this section: You can:
6 Understanding the sof tware



The Print Properties screen appears along with the I Want To menu.

The I Want To menu
The I Want To menu displays when you open Print Properties. It contains a variety of task 
wizards to help you select the correct print settings for your project. Close the menu for a 
full view of the Print Properties dialog box.

Print Properties tabs
All of the print settings are on the three main tabs of the Print Properties software. The 
following table describes each of the tabs.

 NOTE: For additional information about these settings, right-click a setting on the screen, and 
then select the What’s This? item. 

From this tab: You can change these settings:

Quality/Copies Quality/Speed—Select a Quality/Speed setting. 

Multiple Copies—Customize how the printer prints several copies of a 
single print job, collated or normal.

Print Color Images in Black and White—Select this to print color images 
in black and white.

Paper Setup Type—Select the type of paper you are using.

Paper Size—Select the size of the paper you are using.

Orientation—Select how you want the document oriented on the printed 
page. You can print portrait or landscape.

Print Layout Layout—Select the layout you want to print.

Duplexing—Select this when you want to print on both sides of the paper.

I Want To menu
Select one of the 
projects from the menu 
to help print photos, 
banners, envelopes, 
posters, and more.

Print Properties tabs
Use the Quality/Copies, 
Paper Setup, and Print 
Layout tabs to select 
the print settings.
Understanding the sof tware 7
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 Save Settings menu
From the Save Settings menu, you can name and save the current Print Properties settings 
for future use. You can save up to five custom settings.

Options menu
Use the Options menu to make changes to the Quality, Layout, and Printing Status Options 
settings. For more information on these settings, open the tab dialog box from the menu, 
and then click the Help button located in the lower right corner of the screen. 

The Options menu also provides you with direct links to different parts of the Dell Printer 
Solution Center (see page 8), as well as software version information.

Using the Dell Printer Solution Center
The Dell Printer Solution Center is a guide you can refer to for printer help and to check 
the current print status.

To open the Dell Printer Solution Center, click Start → Programs → Dell 
Printers → Dell AIO Printer A920 → Dell Printer Solution Center. 

The Dell Printer Solution Center appears.

Printer Status

Ink levels
8 Understanding the sof tware



The following table describes the Dell Printer Solution Center tabs.

 NOTE: For more information, click the Help button located in the lower right corner of the 
screen.

From this tab: You can:

Printer Status (the tab 
that appears on Start)

• Check the current printer status. For example, while printing, the status 
is Busy Printing.

• See what type of paper is loaded into your printer.
• View ink levels. 

How To • Receive information about basic features.
• Receive scan, copy, fax, and print instructions.
• Receive project information.
• Search the electronic guide.
• Go online to view more ideas.

Troubleshooting • Check the current printer status.
• View recommended Help topics.
• View common troubleshooting topics.
• Search for more specific troubleshooting topics.
• Visit the support area online.

Maintenance • Install a new ink cartridge.
NOTE: Wait until scanning is complete before installing new cartridges.
• View shopping options for new cartridges.
• Print a test page.
• Clean the ink cartridge nozzles.
• Align the ink cartridges.
• Solve other ink problems.
• Visit the supplies area online.
NOTE: Some links will not work while a job is in progress.

Contact Information • View information about ordering ink or supplies.
• View information about contacting Dell Customer Support.
• View a list of phone numbers.
• Visit the Dell website.

Advanced • Change the printing status window appearance options.
• View software version information.
Understanding the sof tware 9
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 Using the Dell Image Expert
The Dell Image Expert lets you adjust photo attributes. With the Dell Image Expert, you 
can:

There are two ways to open the Dell Image Expert:

• Click Start → Programs → Dell Computer → Dell Image Expert. 

• From the All-In-One Center send a scanned image to list, select Dell Image Expert.

For detailed instructions using the Dell Image Expert, refer to the documentation. 

The User’s Guide can be found at C:\Program Files\Dell Computer\Dell ImageExpert\Dell 
Image Expert User’s Guide.pdf.

If you purchased your printer separately
Use the Dell Photo Editor for your graphic editing needs.

To access the Dell Photo Editor:

• From the All-In-One Center send a scanned image to list, select Dell Photo Editor.

Use the touch-up tools to edit your graphic.

 NOTE: Move your pointer over the tool for a description or click the Help button for instructions 
on how to use the tool.

Eliminate red eye Rotate images Attach images to e-mail

Add text to images Resize images Create and share slideshows

Add special effects Create Web pages Make a series of images into a movie

• Remove Red Eye • Crop • Paint Brush

• Pencil • Text • Line

• Eye Dropper • Flood Fill • Eraser
10 Understanding the sof tware
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 Loading paper
To load other paper types, follow the guidelines on page 13.

To load most types of paper:

1 Place the paper against the right side of the paper support with the print side facing 
you and the top of the paper feeding into the paper support.

2 Squeeze and slide the paper guide to the left edge of the paper.

 NOTE: Do not force paper into the printer.
12 Using the printer



 NOTE: To avoid smearing ink, remove each transparency or photo from the paper exit tray 
before the next one exits the printer. Transparencies and photos may require up to 15 minutes to 
dry.

You can load up to: Make sure:

100 sheets of plain paper The paper is designed for use with inkjet printers.
• The envelopes are loaded vertically against the right side of the 

paper support.
• The stamp location is in the upper left corner.
• The envelopes are designed for use with inkjet printers.
• You squeeze and slide the paper guide to the left edge of the 

envelope (as shown).
NOTE: Do not load envelopes with:
• Holes, perforations, cutouts, or deep embossing.
• Metal clasps, string ties, or metal folding bars.
• Exposed flap adhesive.

10 envelopes

25 sheets of labels The labels are designed for use with inkjet printers.

10 sheets of card stock • The card stock is designed for use with inkjet printers.
• The thickness does not exceed 0.025 inches.

10 greeting cards, index cards, 
postcards, or photo cards

The cards are loaded vertically against the right side of the paper 
support.

25 sheets of coated, photo, or 
glossy paper

The glossy or coated side faces you.

10 transparencies • The transparencies are designed for use with inkjet printers.
• The rough side faces you.

100 sheets of custom size 
paper

Your paper size fits within these dimensions:

Width 
– 76 to 216 mm
– 3.0 to 8.5 in.

Length 
– 127 to 432 mm
– 5.0 to 17.0 in. 

25 iron-on transfers • You follow the loading instructions on the iron-on packaging.
• The blank side faces you.

20 sheets of banner paper The banner paper is designed for use with inkjet printers.
Using the printer 13
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 Before you begin copying, scanning, printing, or sending faxes, refer to the information 
below about how much paper the printer exit tray can hold. 

The printer paper exit tray can hold:

• 25 sheets of paper • 10 envelopes

• 10 sheets of labels • 10 cards

• 1 transparency • 1 sheet of coated, photo, or glossy paper
14 Using the printer



Placing your document on the scanner glass
1 Open the top cover.

2 Place the item you want to copy face down on the scanner glass.

 NOTE: Make sure the upper left corner of the front of the item aligns with the arrow.

3 Close the scanner lid to avoid dark edges.
Using the printer 15
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 Printing
The Print Properties I Want To menu (see page 7) provides you with printing wizards to 
help you complete tasks such as printing banners, photographs, or posters.

1 Load paper. For help, see page 12.

2 With your document open, click File → Print. 

3 To change the printer settings, click Properties, Preferences, Options, or Setup 
(depending on the program or operating system). 

The Print Properties dialog box displays.

4 On the three tabs along the left side (Quality/Copies, Paper Setup, and Print Layout) 
of the Print Properties screen, confirm the selections

5 Click OK or Print (depending on the program or operating system).

 NOTE: To see details about a setting on the Quality/Copies, Paper Setup, or Print Layout tabs, 
right-click the setting on the screen, and then select the What’s This? item. 

Printing photos

1 Load paper. For help, see page 12.

2 With your document open, click File → Print. 

3 To change the printer settings, click Properties, Preferences, Options, or Setup 
(depending on the program or operating system). 

The Print Properties dialog box displays.

4 On the three tabs along the left side of the Print Properties screen, confirm your 
selections.

5 Click OK or Print (depending on the program or operating system).

 NOTE: If using photo paper, make sure the glossy side is facing you when you insert the paper 
into the paper support.
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Copying
1 Place your document on the scanner glass. For help, see page 15.

2 Make sure your computer and your printer are on.

3 Open the Dell All-In-One Center. For help, see page 4.

The All-In-One Main page appears.

4 Click Preview Now to see your scanned image.

5 Select a quantity and color for your copies.

To further customize your copy job, click See More Copy Settings.

6 When you are finished customizing your image, click Copy Now.

Copying photos

1 Place your photo on the scanner glass. For help, see page 15.

2 Make sure your computer and printer are on.

3 Open the Dell All-In-One Center. For help, see page 4.

4 Click Preview Now.

5 Adjust the dotted lines to fit around the part of the image you want to print.

6 From the Copy... Section, select Photo.

7 Select a copy quantity and color.

To further customize your photo, click See More Copy Settings.

8 When you are finished customizing your settings, click Copy Now.
Using the printer 17
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 Scanning
The following steps show you how to scan and save images.

1 Place your document on the scanner glass. For help, see page 15.

2 Open the Dell All-In-One Center. For help, see page 4.

The All-In-One Main page appears.

3 Click Preview Now to see your scanned image.

4 Adjust the dotted lines to fit around the part of the image you want to print.

5 From the Send scanned image to: drop-down box, select your scan destination.

To further customize your scan job, click See More Scan Settings.

6 When you are finished customizing your image, click Scan Now.

Scanning photos

1 Place your photo on the scanner glass. For help, see page 15.

2 Open the Dell All-In-One Center. For help, see page 4.

3 Click Preview Now.

4 Adjust the dotted lines to fit around the portion of the image you want to print.

5 Select your scan destination from the drop-down box.

6 When you are finished customizing your image, click Scan Now.

7 When your document has finished processing, it will open the program you chose to 
send the image to.

Editing scanned images
With most graphics programs, you can customize your image.

1 From the Dell All-In-One Center, scan your image to the image editor of your choice.

2 Edit the image using the tools available in your program.

You may be able to:

• Remove red eye

• Crop your image
18 Using the printer



• Add text to your image

• Adjust the brightness and contrast of the image

• Flip or rotate your image

• Change colors

For help, refer to the documentation that came with your graphics program.

Using special scan features
You can use your printer software to scan in many ways. You can:

• Repeat images 

• Autofit

• Multi-up—A printer software option that lets you print multiple pages of a document 
on a single sheet of paper. For example, select 4-up to print reduced images of page 1 
through 4 on the first sheet of paper, images of pages 5 through 8 on the second sheet 
and so on.

• Use Optical Character Recognition to edit text on a document. For help, see Using 
Optical Character Recognition.

Using Optical Character Recognition
Optical Character Recognition (OCR) is a software feature that turns a scanned image into 
editable text within a word processing program.

1 Place your document on the scanner glass. For help, see page 15.

2 Open the Dell All-In-One Center. For help, see page 4.

The All-In-One Main page appears.

3 From the Creative Tasks section, click Edit text found in a scanned document 
(OCR).

4 Follow the instructions on your computer screen.

5 When your document has finished processing, it will open in the word processing 
application you chose.

6 Edit your document.
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 Faxing
In order to send and receive faxes with your printer:

• Your computer must have faxing software installed and configured. You may use BVRP 
Classic Phone Tools/FaxTools or Microsoft Fax Console.

– See "Using BVRP fax software" on page 21 to use BVRP.

– See "Using Fax Console" on page 24 to use Fax Console.

• Your computer must be equipped with a data/fax modem.

 NOTE: A data/fax modem is not built into your printer.

• An active telephone line must be connected to the line-in connector of your data/fax 
modem.

 NOTE: DSL (digital subscriber line), ISDN (integrated services digital network) and cable 
modems are not fax modems and are not supported.

• Your printer must be connected to the computer with a USB cable.

printer connector

computer connector

USB cable
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Using BVRP fax software
Installing BVRP fax software

1 Click the Start button.

2 Click All Programs.

A list of your installed software appears.

3 Check for any entry referring to Classic PhoneTools or FaxTools. If you have either of 
these entries, skip to “Configuring BVRP fax software.”

4 Click on the desktop. 

The All Programs window closes.

5 Insert the Dell Personal All-In-One Printer A920 Drivers and Utilities CD.

An installation window appears.

6 Click Cancel, click the Start button, and then click My Computer.

7 Right-click the CD Drive icon.

A drop-down menu appears.

8 Click Explore.

9 Double-click the Fax folder.

10 Double-click the appropriate language folder.

11 Double-click the Setup icon.

The Installation Wizard appears.

12 Follow the instructions on your computer screen to complete the installation.

Configuring BVRP fax software

 NOTE: Fax service is set by default to automatically answer your phone line after two rings if 
you click to select the Enable Receive check box. Change these settings as desired.

1 Click the Start button.

2 Click All Programs.

3 Click FaxTools or Classic PhoneTools.

The fax configuration wizard begins.
Using the printer 21



w
w

w
.d

e
ll

.c
o

m
/s

u
p

p
li

e
s 

|
 s

u
p

p
o

rt
.d

e
ll

.c
o

m
 4 Click Next.

5 Read the license agreement, and then click Yes to continue.

6 Enter your name and company name.

7 Click Next.

8 Enter an identifier, phone number, and fax number.

9 Click Next, click Next, and click Next again.

10 Click Finish.

BVRP fax software launches.

11 Select your country, enter your area code, and enter any number you must press first 
before getting to an outside line.

12 Click OK.

13 Select your location and click OK.

14 Click Next, click Next, select your modem, and click Next again.

15 Click Next, click Next, and then click Finish.

Sending a one-page fax with BVRP

1 Click the Start button.

2 Move your mouse pointer over All Programs, then Dell Printers, and then Dell AIO 
Printer A920.

3 Click Dell All-In-One Center.

4 Place the document you want to fax face down under the lid of the printer.

5 Select Fax using your computer’s modem under Creative Tasks.

6 Select the correct option for your document under What is being scanned.

7 Select No under Is there more than one page.

8 Click Next.

The document is scanned and BVRP launches.
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Sending a multiple-page fax with BVRP

1 Click the Start button.

2 Move your mouse pointer over All Programs, then Dell Printers, and then Dell AIO 
Printer A920.

3 Click Dell All-In-One Center.

4 Click See More Scan Settings.

5 Click Display Advanced Scan Settings.

6 Click to select Scan multiple items before output.

7 Click OK.

8 Select Fax from the Send scanned image to drop-down menu.

9 Place the document you want to fax face down under the lid of the printer.

10 Click Preview Now.

A preview of your document appears. Adjust your document and repeat if necessary.

11 Click Yes until all pages you want to fax are scanned, and then click No.

12 Follow the instructions on your computer screen to send your fax.

Receiving faxes with BVRP

 NOTE: The computer must be turned on and BVRP FaxTools must be configured in order to 
receive a fax.

1 Click the Start button.

2 Click All Programs.

3 Click Classic PhoneTools or FaxTools.

BVRP fax software launches. You are now ready to receive a fax.

Viewing your faxes in BVRP

1 Click the Start button.

2 Click All Programs.

3 Click Classic PhoneTools or FaxTools.

4 Click Fax Inbox to view received faxes.

5 Click Fax Outbox to view sent faxes.
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 Using Fax Console
Installing Fax Console

1 Click the Start button.

2 Click Control Panel.

3 Click Add or Remove Programs.

4 Click Add/Remove Windows Components.

5 Click to select Fax Services.

6 Click Next.

If prompted, insert the Microsoft Windows XP CD and click OK. Close the Welcome 
to Microsoft Windows XP window when it opens.

7 Click Finish.

8 Close the Add/Remove Programs window.

Configuring Fax Console

1 Click the Start button.

2 Move your mouse pointer over All Programs, then Accessories, then 
Communications, then Fax.

3 Click Fax Console.

The Welcome to Fax Configuration Wizard appears.

4 Click Next.

5 Enter any appropriate information and click Next.

6 Select your data/fax modem in the drop-down menu under Please select the fax 
device.

7 Select or de-select the Enable Send and Enable Receive check boxes as desired.

 NOTE: De-selecting the Enable Send check box prevents you from sending faxes. Selecting the 
Enable Receive check box allows you to receive faxes.

8 Enter your TSID information and click Next.

9 Enter your CSID information and click Next.
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10 Click to select Print it on and use the drop-down menu to the right of this field to 
select Dell AIO Printer A920 if you want to print all received faxes.

11 To create an archive copy of each fax, click to select Store a copy in a folder and use 
the Browse button to select the desired archive location.

12 Click Next, confirm your settings, and click Finish.

Sending a one-page fax with Fax Console

1 Click the Start button.

2 Move your mouse pointer over All Programs, then Dell Printers, and then Dell AIO 
Printer A920.

3 Click Dell All-In-One Center.

4 Place the document you want to fax face down under the lid of the printer.

5 Select Fax using your computer’s modem under Creative Tasks.

6 Select the correct option for your document under What is being scanned.

7 Select No under Is there more than one page.

8 Click Next.

The document is scanned and BVRP launches.

Sending a multiple-page fax with Fax Console

1 Click the Start button.

2 Move your mouse pointer over All Programs, then Dell Printers, then Dell AIO 
Printer A920.

3 Click Dell All-In-One Center.

4 Click See More Scan Settings.

5 Click Display Advanced Scan Settings.

6 Click to select Scan multiple items before output, and click OK.

7 Select Fax from the Send scanned image to drop-down menu.

8 Place the document you want to fax face down under the lid of the printer.

9 Click Preview Now.

A preview of your document appears. Adjust your document and repeat if necessary.
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 10 Click Yes until all pages you want to fax are scanned.

11 Click No.

12 Follow the instructions on your computer screen to send your fax.

Receiving faxes with Fax Console

1 Click the Start button.

2 Move your mouse pointer over All Programs, then Accessories, then 
Communications, then Fax.

3 Click Fax Console.

You are now ready to receive a fax if you selected the Enable Receive check box when 
configuring Fax Console.

Viewing faxes with Fax Console

1 Click the Start button.

2 Move your mouse pointer over All Programs, then Accessories, then 
Communications, then Fax.

3 Click Fax Console.

Received faxes can be viewed in the Inbox. Sent faxes can be viewed in Sent Items.

Fax troubleshooting
If you are having trouble sending or receiving a fax, ensure that:

• Your computer is equipped with a working data/fax modem.

• An active phone line is connected to the line-in connector of your data/fax modem.

• Faxing software is installed and configured.

• Your printer is connected to the computer with a USB cable.
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Creating other projects
You can create other projects by following wizards provided in the software. Select a project 
from one of the following locations and follow the instructions on the screen.

• From the Dell All-In-One Center Creative Tasks section. For help accessing the Dell 
All-In-One Center, see page 4.

• From the Print Properties I Want To menu. For help accessing Print Properties, see 
page 6.

• From the Dell Printer Solution Center How To tab. For help accessing the Dell Printer 
Solution Center, see page 8.
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 Ordering supplies
Your Dell Personal AIO Printer A920 comes with software installed to detect the ink levels 
in the printer. During a print job, a screen appears on your computer to warn you if the ink 
levels are low. To order more ink, follow the instructions on the screen or visit the Dell 
website at www.dell.com/supplies or www.dell.euro.com/supplies.

Your printer has been designed to print using the following cartridges:

Refer to the setup documentation for help installing ink cartridges.

Replacing the ink cartridges
 CAUTION: Before performing any of the procedures listed in this section, read 
and follow the Safety Instructions on page iv.

1 Make sure the printer is on.

2 Lift the printer (scanner unit) until the scanner support keeps it open. 

The ink cartridge carrier moves and stops at the loading position unless the printer is 
busy.

3 Squeeze the tabs on the cartridge lids, and then lift the lids.

4 Remove the old cartridges. Store them in an air-tight container or dispose of them.

5 If you are installing new cartridges, remove the stickers and tape from the bottom of 
the cartridges.

Item: Part number:

Black ink cartridge T0529

Color ink cartridge T0530
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 NOTICE: Do not touch the gold contact area on the cartridges. 

6 Insert the new cartridges. Make sure the color ink cartridge is secure in the left carrier 
and the black cartridge is secure in the right carrier, and then snap the lids closed. 

7 Lift the printer (scanner unit) and push the scanner support back while lowering the 
printer (scanner unit) until it is closed.

Aligning the ink cartridges
There are two instances when you will align your ink cartridges: after installing cartridges 
and to improve print quality.

To align the ink cartridges:

1 Load plain paper in the printer. For help, see page 12.

2 Open the Dell Printer Solution Center. For help, see page 8.

3 From the Maintenance tab, click Align to fix blurry edges.

4 Click Print.

An alignment page prints.

5 To manually align your cartridges, select the best alignment values from the alignment 
page.

a Find the number under the darkest arrow for each alignment group.

b Use the arrows in the Align Cartridges dialog box to select the number that 
matches the arrow you chose from the printed page.

c Once you have selected a number for each of the alignment groups, click OK.

 NOTE: If the alignment page does not print, make sure you have completely removed the 
stickers and transparent tape from both ink cartridges, and then try to align the cartridges 
again.
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 Cleaning the ink cartridge nozzles
To improve print quality, you may need to clean the ink cartridge nozzles.

Clean the nozzles when:

• Characters are not printing completely.

• White dashes appear in graphics or printed text.

• Print is smudged or too dark.

• Colors on print jobs are faded or they differ from the colors on the screen.

• Vertical, straight lines are not smooth.

To clean the nozzles:

1 Load plain paper in the printer. For help, see page 12.

2 Open the Dell Printer Solution Center. For help, see page 8.

3 From the Maintenance tab, click Clean to fix horizontal streaks.

4 Click Print.

A nozzle page prints, forcing ink through the nozzles to clean the clogged nozzles.

5 Print your document again to verify your print quality has improved.

If print quality has not improved, try cleaning the ink cartridge nozzles up to two more 
times.

To further improve print quality, try wiping the ink cartridge nozzles and contacts 
(refer to your User’s Guide), and then print your document again.
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 Setup troubleshooting
If you experience problems while setting up your printer, make sure:

• You only have one Dell Personal AIO Printer A920 attached to your computer.

• Your operating system is compatible with your printer. The Dell Personal AIO Printer 
A920 supports both Microsoft ® Windows® XP and Windows 2000.

General troubleshooting
When your printer has a problem, before contacting Dell Customer Support, check the 
following items. Make sure:

• The power supply is firmly attached to the printer and an electrical outlet.

• The USB cable is securely attached to your computer and to your printer. 

• Both your computer and your printer are on.

• The Dell AIO Printer A920 is set as your default printer. To check: click Start →  
Settings → Printers or Start → Control Panel → Printers and Other Hardware →  
Printers and Faxes. Right-click the Dell AIO Printer A920 icon, and then select Set as 
Default Printer. 

• You removed the stickers and tape from the bottom of the ink cartridges. For help, 
refer to the setup documentation.

• The paper is loaded correctly. For help, see page 12.

 NOTE: Do not force paper into the printer.

• You installed both of the ink cartridges. The Dell AIO Printer A920 will only work if 
you have both cartridges installed. 

• The color ink cartridge is secure in the left carrier and the black ink cartridge is secure 
in the right carrier.

• The printer software was installed correctly. For help, refer to the setup 
documentation.

More troubleshooting
If you checked all the items above and are still having a problem, refer to your User’s Guide.

Click Start → Programs → Dell Printers → Dell AIO Printer A920 → User’s Guide.
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 Federal Communications Commission (FCC) compliance information 
statement 
The Dell Personal AIO Printer A920 has been tested and found to comply with the limits 
for a Class B digital device, pursuant to Part 15 of the FCC Rules. Operation is subject to 
the following two conditions: (1) this device may not cause harmful interference, and (2) 
this device must accept any interference received, including interference that may cause 
undesired operation.

The FCC Class B limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses and can radiate 
radio frequency energy and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications. However, there is no guarantee 
that interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by turning 
the equipment off and on, the user is encouraged to try to correct the interference by one or 
more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which 
the receiver is connected.

• Consult your point of purchase or service representative for additional 
suggestions.

The manufacturer is not responsible for any radio or television interference caused by using 
other than recommended cables or by unauthorized changes or modifications to this 
equipment. Unauthorized changes or modifications could void the user's authority to 
operate this equipment.

 NOTE: To assure compliance with FCC regulations on electromagnetic interference for a Class 
B computing device, use a properly shielded and grounded cable. Use of a substitute cable not 
properly shielded and grounded may result in a violation of FCC regulations.

Any questions regarding this compliance information statement should be directed to: 

Dell Products, L.P. 

One Dell Way

Round Rock, Texas 78682 USA
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Industry Canada compliance statement 
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing 
Equipment Regulations.

Avis de conformité aux normes d’Industrie Canada 

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le 
matériel brouilleur du Canada.

European Community (EC) directives conformity 
A declaration of conformity with the requirements of the directives has been signed by the 
Director of Manufacturing and Technical Support, Lexmark International, S.A., Boigny, 
France. 

This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.

The United Kingdom Telecommunications Act 1984 
This apparatus is approved under the approval number NS/G/1234/J/100003 for the indirect 
connections to the public telecommunications systems in the United Kingdom.

Noise emission levels 
The following measurements were made in accordance with ISO 7779 and reported in 
conformance with ISO 9296.

1-meter average sound pressure, dBA

Printing 44 dBA

Copying 44 dBA

Scanning 38 dBA

Faxing 38 dBA
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 ENERGY STAR

The EPA ENERGY STAR Office Equipment program is a partnership effort with office 
equipment manufacturers to promote the introduction of energy-efficient products and to 
reduce air pollution caused by power generation.

Companies participating in this program introduce products that power down when they 
are not being used. This feature will cut the energy used by up to 50 percent. Dell is proud 
to be a participant in this program.

As an ENERGY STAR Partner, Dell International, Inc. has determined that this product 
meets the ENERGY STAR guidelines for energy efficiency. 

Copyright advisory
It may be illegal to copy certain materials without permission or license, including 
documents, images, and currency. If you are not sure whether you have permission, seek 
legal advice. 
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 Contacting Dell
To contact Dell electronically, you can access the following websites:

• www.dell.com

• support.dell.com (technical support)

• premiersupport.dell.com (technical support for educational, government, healthcare, 
and medium/large business customers, including Premier, Platinum, and Gold 
customers)

For specific web addresses for your country, find the appropriate country section in the table 
below. 

NOTE: Toll-free numbers are for use within the country for which they are listed.

When you need to contact Dell, use the electronic addresses, telephone numbers, and 
codes provided in the following table. If you need assistance in determining which codes to 
use, contact a local or an international operator.

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers

Anguilla General Support toll-free: 800-335-0031

Antigua and Barbuda General Support 1-800-805-5924

Argentina (Buenos Aires)

International Access Code: 00

Country Code: 54

City Code: 11

Website: www.dell.com.ar

Tech Support and Customer Care  toll-free: 0-800-444-0733

Sales 0-810-444-3355

Tech Support Fax  11 4515 7139

Customer Care Fax  11 4515 7138

Aruba General Support toll-free: 800-1578

Bahamas General Support toll-free: 1-866-278-6818

Barbados General Support 1-800-534-3066
40 Appendix



Belgium (Brussels)

International Access Code: 00

Country Code: 32

City Code: 2

Website: support.euro.dell.com

E-mail: tech_be@dell.com

E-mail for French Speaking Customers: 
support.euro.dell.com/be/fr/emaildell/

Technical Support 02 481 92 88

Customer Care 02 481 91 19

Corporate Sales 02 481 91 00

Fax 02 481 92 99

Switchboard 02 481 91 00

Bolivia General Support toll-free: 800-10-0238

Brazil

International Access Code: 00

Country Code: 55

City Code: 51

Website: www.dell.com/br

Customer Support, Technical Support 0800 90 3355

Tech Support Fax  51 481 5470

Customer Care Fax  51 481 5480

Sales 0800 90 3390

British Virgin Islands General Support toll-free: 1-866-278-6820

Canada (North York, Ontario)

International Access Code: 011

Online Order Status: www.dell.ca/ostatus

AutoTech (automated technical support) toll-free: 1-800-247-9362

TechFax toll-free: 1-800-950-1329

Customer Care (Home Sales/Small Business) toll-free: 1-800-847-4096

Customer Care (med./large business, government) toll-free: 1-800-326-9463

Technical Support (Home Sales/Small Business) toll-free: 1-800-847-4096

Technical Support (med./large bus., government) toll-free: 1-800-387-5757

Sales (Home Sales/Small Business) toll-free: 1-800-387-5752

Sales (med./large bus., government) toll-free: 1-800-387-5755

Spare Parts Sales & Extended Service Sales 1 866 440 3355

Cayman Islands General Support 1-800-805-7541

Colombia General Support 980-9-15-3978

Costa Rica General Support 0800-012-0435

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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Denmark (Copenhagen)

International Access Code: 00

Country Code: 45 

Website: support.euro.dell.com

E-mail Support (portable computers): 
den_nbk_support@dell.com

E-mail Support (desktop computers): 
den_support@dell.com

E-mail Support (servers): 
Nordic_server_support@dell.com

Technical Support 7023 0182

Customer Care (Relational) 7023 0184

Home/Small Business Customer Care 3287 5505

Switchboard (Relational) 3287 1200

Fax Switchboard (Relational) 3287 1201

Switchboard (Home/Small Business) 3287 5000

Fax Switchboard (Home/Small Business) 3287 5001

Finland (Helsinki)

International Access Code: 990

Country Code: 358

City Code: 9

Website: support.euro.dell.com

E-mail: fin_support@dell.com

E-mail Support (servers): 
Nordic_support@dell.com

Technical Support 09 253 313 60

Technical Support Fax 09 253 313 81

Relational Customer Care 09 253 313 38

Home/Small Business Customer Care 09 693 791 94

Fax 09 253 313 99

Switchboard 09 253 313 00

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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France (Paris) (Montpellier)

International Access Code: 00

Country Code: 33

City Codes: (1) (4)

Website: support.euro.dell.com

E-mail: support.euro.dell.com/fr/fr/emaildell/

Home and Small Business

Technical Support 0825 387 270

Customer Care 0825 823 833

Switchboard 0825 004 700

Switchboard (calls from outside of France) 04 99 75 40 00

Sales 0825 004 700

Fax 0825 004 701

Fax (calls from outside of France) 04 99 75 40 01

Corporate

Technical Support 0825 004 719

Customer Care 0825 338 339

Switchboard 01 55 94 71 00

Sales 01 55 94 71 00

Fax 01 55 94 71 01

Germany (Langen)

International Access Code: 00

Country Code: 49

City Code: 6103

Website: support.euro.dell.com

E-mail: tech_support_central_europe@dell.com

Technical Support 06103 766-7200

Home/Small Business Customer Care 0180-5-224400

Global Segment Customer Care 06103 766-9570

Preferred Accounts Customer Care 06103 766-9420

Large Accounts Customer Care 06103 766-9560

Public Accounts Customer Care 06103 766-9555

Switchboard 06103 766-7000

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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Greece

International Access Code: 00

Country Code: 30

Website: support.euro.dell.com

E-mail: support.euro.dell.com/gr/en/emaildell/

Technical Support 080044149518

Gold Technical Support 08844140083

Switchboard 2108129800

Sales 2108129800

Fax 2108129812

Grenada General Support toll-free: 1-866-540-3355

Guyana General Support toll-free: 1-877-270-4609

India Technical Support 1600 33 8045

Sales 1600 33 8044

Ireland (Cherrywood)

International Access Code: 16

Country Code: 353

City Code: 1

Website: support.euro.dell.com

E-mail: dell_direct_support@dell.com

Ireland Technical Support 1850 543 543

U.K. Technical Support (dial within U.K. only) 0870 908 0800

Home User Customer Care 01 204 4014

Small Business Customer Care 01 204 4014

U.K. Customer Care (dial within U.K. only) 0870 906 0010

Corporate Customer Care 1850 200 982

Corporate Customer Care (dial within U.K. only) 0870 907 4499

Ireland Sales 01 204 4444

U.K. Sales (dial within U.K. only) 0870 907 4000

Fax/SalesFax 01 204 0103

Switchboard 01 204 4444

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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Italy (Milan)

International Access Code: 00

Country Code: 39

City Code: 02

Website: support.euro.dell.com

E-mail: support.euro.dell.com/it/it/emaildell/

Home and Small Business

Technical Support 02 577 826 90

Customer Care 02 696 821 14

Fax 02 696 821 13

Switchboard 02 696 821 12

Corporate

Technical Support 02 577 826 90

Customer Care 02 577 825 55

Fax 02 575 035 30

Switchboard 02 577 821

Jamaica General Support (dial from within Jamaica only) 1-800-682-3639

Latin America Customer Technical Support (Austin, Texas, 
U.S.A.)

512 728-4093

Customer Service (Austin, Texas, U.S.A.) 512 728-3619

Fax (Technical Support and Customer Service) 
(Austin, Texas, U.S.A.)

512 728-3883

Sales (Austin, Texas, U.S.A.) 512 728-4397

SalesFax (Austin, Texas, U.S.A.) 512 728-4600

or 512 728-3772

Luxembourg

International Access Code: 00

Country Code: 352

Website: support.euro.dell.com

E-mail: tech_be@dell.com

Technical Support (Brussels, Belgium) 3420808075

Home/Small Business Sales (Brussels, Belgium) toll-free: 080016884

Corporate Sales (Brussels, Belgium) 02 481 91 00

Customer Care (Brussels, Belgium) 02 481 91 19

Fax (Brussels, Belgium) 02 481 92 99

Switchboard (Brussels, Belgium) 02 481 91 00

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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Mexico

International Access Code: 00

Country Code: 52

Customer Technical Support 001-877-384-8979

or 001-877-269-3383

Sales 50-81-8800

or 01-800-888-3355

Customer Service 001-877-384-8979

or 001-877-269-3383

Main 50-81-8800

or 01-800-888-3355

Netherlands Antilles General Support 001-800-882-1519

Netherlands (Amsterdam)

International Access Code: 00

Country Code: 31

City Code: 20

Website: support.euro.dell.com

E-mail (Technical Support):

(Enterprise): nl_server_support@dell.com

(Latitude): nl_latitude_support@dell.com

(Inspiron): nl_inspiron_support@dell.com

(Dimension): nl_dimension_support@dell.com

(OptiPlex): nl_optiplex_support@dell.com

(Dell Precision): nl_workstation_support@dell.com

Technical Support 020 674 45 00

Technical Support Fax 020 674 47 66

Home/Small Business Customer Care 020 674 42 00

Relational Customer Care  020 674 4325

Home/Small Business Sales 020 674 55 00

Relational Sales 020 674 50 00

Home/Small Business Sales Fax 020 674 47 75

Relational Sales Fax 020 674 47 50

Switchboard 020 674 50 00

Switchboard Fax 020 674 47 50

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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Norway (Lysaker)

International Access Code: 00

Country Code: 47

Website: support.euro.dell.com

E-mail Support (portable computers):

nor_nbk_support@dell.com

E-mail Support (desktop computers):

nor_support@dell.com

E-mail Support (servers):

nordic_server_support@dell.com

Technical Support 671 16882

Relational Customer Care 671 17514

Home/Small Business Customer Care 23162298

Switchboard 671 16800

Fax Switchboard 671 16865

Poland (Warsaw)

International Access Code: 011

Country Code: 48

City Code: 22

Website: support.euro.dell.com

E-mail: pl_support@dell.com

Customer Service Phone 57 95 700

Customer Care 57 95  999

Sales 57 95 999

Customer Service Fax 57 95 806

Reception Desk Fax 57 95 998

Switchboard 57 95 999

Portugal

International Access Code: 00

Country Code: 351

Website: support.euro.dell.com

E-mail: support.euro.dell.com/pt/en/emaildell/

Technical Support 707200149

Customer Care 800 300 413

Sales 800 300 410 or 800 300 411 or
800 300 412 or 21 422 07 10

Fax 21 424 01 12

Puerto Rico General Support 1-800-805-7545

St. Kitts and Nevis General Support toll-free: 1-877-441-4731

St. Lucia General Support 1-800-882-1521

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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St. Vincent and the Grenadines General Support toll-free: 1-877-270-4609

Singapore (Singapore)

International Access Code: 005

Country Code: 65

Technical Support toll-free: 800 6011 051

Customer Service (Penang, Malaysia) 604 633 4949

Transaction Sales toll-free: 800 6011 054

Corporate Sales toll-free: 800 6011 053

Spain (Madrid)

International Access Code: 00

Country Code: 34

City Code: 91

Website: support.euro.dell.com

E-mail: support.euro.dell.com/es/es/emaildell/

Home and Small Business

Technical Support 902 100 130

Customer Care 902 118 540

Sales 902 118 541

Switchboard 902 118 541

Fax 902 118 539

Corporate

Technical Support 902 100 130

Customer Care 902 118 546

Switchboard 91 722 92 00

Fax 91 722 95 83

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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Sweden (Upplands Vasby)

International Access Code: 00

Country Code: 46

City Code: 8

Website: support.euro.dell.com

E-mail: swe_support@dell.com

E-mail Support for Latitude and Inspiron: 
Swe-nbk_kats@dell.com

E-mail Support for OptiPlex: Swe_kats@dell.com

E-mail Support for Servers: 
Nordic_server_support@dell.com

Technical Support 08 590 05 199

Relational Customer Care 08 590 05 642

Home/Small Business Customer Care 08 587 70 527

Employee Purchase Program (EPP) Support 20 140 14 44

Fax Technical Support 08 590 05 594

Sales 08 590 05 185

Switzerland (Geneva)

International Access Code: 00

Country Code: 41

City Code: 22

Website: support.euro.dell.com

E-mail: swisstech@dell.com

E-mail for French-speaking HSB and Corporate 
Customers: support.euro.dell.com/ch/fr/emaildell/

Technical Support (Home and Small Business) 0844 811 411

Technical Support (Corporate) 0844 822 844

Customer Care (Home and Small Business) 0848 802 202

Customer Care (Corporate) 0848 821 721

Fax 022 799 01 90

Switchboard 022 799 01 01

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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U.K. (Bracknell)

International Access Code: 00

Country Code: 44

City Code: 1344

Website: support.euro.dell.com

Customer Care website: support.euro.dell.com/uk/en/ECare/Form/Home.asp

E-mail: dell_direct_support@dell.com

Technical Support (Corporate/Preferred 
Accounts/PAD [1000+ employees])

0870 908 0500

Technical Support (direct/PAD and general) 0870 908 0800

Global Accounts Customer Care 01344 373 186

Home and Small Business Customer Care 0870 906 0010

Corporate Customer Care 01344 373 185

Preferred Accounts (500–5000 employees) 
Customer Care

0870 906 0010

Central Government Customer Care 01344 373 193

Local Government & Education Customer Care 01344 373 199

Health Customer Care 01344 373 194

Home and Small Business Sales 0870 907 4000

Corporate/Public Sector Sales 01344 860 456

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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U.S.A. (Austin, Texas)

International Access Code: 011

Country Code: 1

Automated Order-Status Service toll-free: 1-800-433-9014

AutoTech (portable and desktop computers) toll-free: 1-800-247-9362

Consumer (Home and Home Office) 

Technical Support toll-free: 1-800-624-9896

Customer Service toll-free: 1-800-624-9897

DellNet™ Service and Support toll-free: 1-877-Dellnet

(1-877-335-5638)

Employee Purchase Program (EPP) Customers toll-free: 1-800-695-8133

Financial Services website: www.dellfinancialservices.com

Financial Services (lease/loans) toll-free: 1-877-577-3355

Financial Services (Dell Preferred Accounts [DPA]) toll-free: 1-800-283-2210

Business 

Customer Service and Technical Support toll-free: 1-800-822-8965

Employee Purchase Program (EPP) Customers toll-free: 1-800-695-8133

Projectors Technical Support toll-free: 1-877-459-7298

Public (government, education, and healthcare)

Customer Service and Technical Support toll-free: 1-800-456-3355

Employee Purchase Program (EPP) Customers toll-free: 1-800-234-1490

Dell Sales toll-free: 1-800-289-3355

 or toll-free: 1-800-879-3355

Dell Outlet Store (Dell refurbished computers) toll-free: 1-888-798-7561

Software and Peripherals Sales toll-free: 1-800-671-3355

Spare Parts Sales toll-free: 1-800-357-3355

Extended Service and Warranty Sales toll-free: 1-800-247-4618

Fax toll-free: 1-800-727-8320

Dell Services for the Deaf, Hard-of-Hearing, or 
Speech-Impaired

toll-free: 1-877-DELLTTY

(1-877-335-5889)

U.S. Virgin Islands General Support 1-877-673-3355

Venezuela General Support 8001-3605

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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 Limited Warranties and Return Policy
Dell-branded hardware products purchased in the U.S. or Canada come with either a 90-day, one-year, two-year, 
three-year, or four-year limited warranty. To determine which warranty came with your hardware product(s), see 
your packing slip or invoice. The following sections describe the limited warranties and return policy for the U.S., 
the limited warranties and return policy for Canada, and the manufacturer guarantee for Latin America and the 
Caribbean.

Limited Warranty for Dell-Branded Hardware Products (U.S. Only)

What is covered by this limited warranty?
This limited warranty covers defects in materials and workmanship in your—our end-user customer's—
Dell-branded hardware products, including Dell-branded peripheral products.

What is not covered by this limited warranty?
This limited warranty does not cover: 

• Software, including the operating system and software added to the Dell-branded hardware products 
through our factory-integration system, third-party software, or the reloading of software

• Non-Dell-branded and Solution Provider Direct products and accessories

• Problems that result from: 

– External causes such as accident, abuse, misuse, or problems with electrical power

– Servicing not authorized by Dell 

– Usage that is not in accordance with product instructions

– Failure to follow the product instructions or failure to perform preventive maintenance 

– Problems caused by using accessories, parts, or components not supplied by Dell

• Products with missing or altered service tags or serial numbers

• Products for which we have not received payment

THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER 
RIGHTS WHICH VARY FROM STATE TO STATE (OR JURISDICTION TO JURISDICTION). DELL'S 
RESPONSIBILITY FOR MALFUNCITONS AND DEFECTS IN HARDWARE IS LIMITED TO REPAIR 
AND REPLACEMENT AS SET FORTH IN THIS WARRANTY STATEMENT. ALL EXPRESS AND 
IMPLIED WARRANTIES FOR THE PRODUCT, INCLUDING BUT NOT LIMITED TO ANY IMPLIED 
WARRANTIES AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE, ARE LIMITED IN TIME TO THE TERM OF THE LIMITED WARRANTY PERIOD 
REFLECTED ON YOUR PACKING SLIP OR INVOICE. NO WARRANTIES, WHETHER EXPRESS OR 
IMPLIED, WILL APPLY AFTER THE LIMITED WARRANTY PERIOD HAS EXPIRED. SOME STATES 
DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THIS 
LIMITATION MAY NOT APPLY TO YOU.
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WE DO NOT ACCEPT LIABILITY BEYOND THE REMEDIES PROVIDED FOR IN THIS LIMITED 
WARRANTY OR FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT 
LIMITATION, ANY LIABILTY FOR THIRD-PARTY CLAIMS AGAINST YOU FOR DAMAGES, FOR 
PRODUCTS NOT BEING AVAILABLE FOR USE, OR FOR LOST DATA OR LOST SOFTWARE. OUR 
LIABILITY WILL BE NO MORE THAN THE AMOUNT YOU PAID FOR THE PRODUCT THAT IS THE 
SUBJECT OF A CLAIM. THIS IS THE MAXIMUM AMOUNT FOR WHICH WE ARE RESPONSIBLE.

SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO 
YOU.

How long does this limited warranty last?
This limited warranty lasts for the time period indicated on your packing slip or invoice, except that the limited 
warranty on Dell-branded batteries lasts only one year and the limited warranty on the lamps for Dell-branded 
projectors lasts only ninety days. The limited warranty begins on the date of the packing slip or invoice. The 
warranty period is not extended if we repair or replace a warranted product or any parts. Dell may change the 
availability of limited warranties, at its discretion, but any changes will not be retroactive.

What do I do if I need warranty service? 
Before the warranty expires, please call us at the relevant number listed in the following table. Please also have your 
Dell service tag number or order number available. 

What will Dell do?
During the 90 days of the 90-day limited warranty and the first year of all other limited warranties: During the 90 
days of the 90-day limited warranty and the first year of all other limited warranties, we will repair any 
Dell-branded hardware products returned to us that prove to be defective in materials or workmanship. If we are 
not able to repair the product, we will replace it with a comparable product that is new or refurbished. 

Individual Home Consumers: U.S. Only

Technical Support 1-800-624-9896

Customer Service 1-800-624-9897

Individual Home Consumers who purchased through 
an Employee Purchase Program:

Technical Support and Customer Service 1-800-822-8965

Home and Small Business Commercial Customers:

Technical Support and Customer Service 1-800-456-3355

Medium, Large, or Global Commercial Customers, 
Healthcare Customers, and Value Added Resellers 
(VARs):

Technical Support and Customer Service 1-877-459-7298

Government and Education Customers: 

Technical Support and Customer Service 1-877-459-7298

Dell-Branded Memory 1-888-363-5150
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 When you contact us, we will issue a Return Material Authorization Number for you to include with your return. 
You must return the products to us in their original or equivalent packaging, prepay shipping charges, and insure 
the shipment or accept the risk if the product is lost or damaged in shipment. We will return the repaired or 
replacement products to you. We will pay to ship the repaired or replaced products to you if you use an address in 
the United States (excluding Puerto Rico and U.S. possessions and territories). Otherwise, we will ship the product 
to you freight collect.

If we determine that the product is not covered under this warranty, we will notify you and inform you of service 
alternatives that are available to you on a fee basis.

NOTE: Before you ship the product(s) to us, make sure to back up the data on the hard drive(s) and any other 
storage device(s) in the product(s). Remove any confidential, proprietary, or personal information and removable 
media such as floppy disks, CDs, or PC Cards. We are not responsible for any of your confidential, proprietary, or 
personal information; lost or corrupted data; or damaged or lost removable media. 

During the remaining years: For the remaining period of the limited warranty, we will replace any defective part 
with new or refurbished parts, if we agree that it needs to be replaced. When you contact us, we will require a valid 
credit card number at the time you request a replacement part, but we will not charge you for the replacement part 
as long as you return the original part to us within thirty days after we ship the replacement part to you. If we do 
not receive the original part within thirty days, we will charge to your credit card the then-current standard price for 
that part. 

We will pay to ship the part to you if you use an address in the United States (excluding Puerto Rico and U.S. 
possessions and territories). Otherwise, we will ship the part freight collect. We will also include a prepaid shipping 
container with each replacement part for your use in returning the replaced part to us. 

NOTE: Before you replace parts, make sure to back up the data on the hard drive(s) and any other storage 
device(s) in the product(s). We are not responsible for lost or corrupted data. 

What if I purchased a service contract?
If your service contract is with Dell, service will be provided to you under the terms of the service agreement. 
Please refer to that contract for details on how to obtain service.

If you purchased through us a service contract with one of our third-party service providers, please refer to that 
contract for details on how to obtain service. 

How will you fix my product?
We use new and refurbished parts made by various manufacturers in performing warranty repairs and in building 
replacement parts and systems. Refurbished parts and systems are parts or systems that have been returned to Dell, 
some of which were never used by a customer. All parts and systems are inspected and tested for quality. 
Replacement parts and systems are covered for the remaining period of the limited warranty for the product you 
bought. Dell owns all parts removed from repaired products.
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What do I do if I am not satisfied?
We pride ourselves on our great customer service. If you are not satisfied with the service you receive under this 
limited warranty, please let us know. We have found that the best way to resolve issues regarding our limited 
warranty is to work together. If, after those discussions, you are still not satisfied, we believe arbitration is the most 
expeditious way to resolve your concerns. Therefore, ANY CLAIM, DISPUTE, OR CONTROVERSY 
(WHETHER IN CONTRACT, TORT, OR OTHERWISE, WHETHER PREEXISTING, PRESENT, OR 
FUTURE, AND INCLUDING STATUTORY, COMMON LAW, INTENTIONAL TORT, AND EQUITABLE 
CLAIMS) AGAINST DELL arising from or relating to this limited warranty, its interpretation, or the breach, 
termination, or validity thereof, the relationships which result from this limited warranty (including, to the full 
extent permitted by applicable law, relationships with third parties), Dell's advertising, or any related purchase 
SHALL BE RESOLVED EXCLUSIVELY AND FINALLY BY BINDING ARBITRATION ADMINISTERED 
BY THE NATIONAL ARBITRATION FORUM (NAF) under its Code of Procedure then in effect (available via 
the Internet at www.arb-forum.com/ or via telephone at 1-800-474-2371). The arbitration will be limited solely to 
the dispute or controversy between you and Dell. Any award of the arbitrator(s) shall be final and binding on each 
of the parties, and may be entered as a judgment in any court of competent jurisdiction. Information may be 
obtained and claims may be filed with the NAF at P.O. Box 50191, Minneapolis, MN 55405. This provision applies 
only to individual home consumers and consumers who purchased through an employee purchase program. It does 
not apply to small, medium, large, and global commercial customers or government, education, and healthcare 
customers.

May I transfer the limited warranty?
Limited warranties on systems may be transferred if the current owner transfers ownership of the system and 
records the transfer with us. The limited warranty on Dell-branded memory may not be transferred. You may 
record your transfer by going to Dell's website: 

• If you are an Individual Home Consumer, go to www.dell.com/us/en/dhs/topics/sbtopic_015_ccare.htm 

• If you are a Home Office, Small, Medium, Large, or Global Commercial Customer, go to 
www.dell.com/us/en/biz/topics/sbtopic_ccare_nav_015_ccare.htm 

• If you are a Government, Education, or Healthcare Customer, or an Individual Home Consumer who 
purchased through an employee purchase program, go to 
www.dell.com/us/en/pub/topics/sbtopic_015_ccare.htm

If you do not have Internet access, call your customer care representative or call 1-800-624-9897. 

"Total Satisfaction" Return Policy (U.S. Only)
We value our relationship with you and want to make sure that you're satisfied with your purchases. That's why we 
offer a "Total Satisfaction" return policy for most products that you—the end-user customer—purchase directly 
from Dell. Under this policy, you may return to Dell products that you purchased directly from Dell for a credit or 
a refund of the purchase price paid, less shipping and handling and applicable restocking fees as follows: 

• New Hardware Products and Accessories — All new hardware, accessories, parts, and unopened software 
still in its sealed package, excluding the products listed below, may be returned within thirty days from the 
date on the packing slip or invoice. To return applications software or an operating system that has been 
installed by Dell, you must return the entire computer. A different return policy applies to nondefective 
products purchased through Dell's Software and Peripherals division by customers of our Small and Medium 
Business divisions. Those products may be returned within thirty days from the date on the packing slip or 
invoice, but a fifteen percent (15%) restocking fee will be deducted from any refund or credit. The "Total 
Satisfaction" Return Policy and Software and Peripherals division return policy are not available for Dell | 
EMC storage products, EMC-branded products, or enterprise software.
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 • Reconditioned or Refurbished Dell-Branded Hardware Products and Parts — All reconditioned or 
refurbished Dell-branded server and storage products may be returned within thirty days from the date on 
the packing slip or invoice. All other reconditioned or refurbished Dell-branded hardware products and parts 
may be returned within fourteen days of the date on the packing slip or invoice. 

To return products, e-mail or call Dell customer service to receive a Credit Return Authorization Number within 
the return policy period applicable to the product you want to return. You must obtain a Credit Return 
Authorization Number in order to return the product. See "Contacting Dell" or "Getting Help" in your customer 
documentation (or www.dell.com/us/en/gen/contact.htm) to find the appropriate contact information for 
obtaining customer assistance.

You must ship the products to Dell within five days of the date that Dell issues the Credit Return Authorization 
Number. You must also return the products to Dell in their original packaging, in as-new condition along with any 
media, documentation, and all other items that were included in the original shipment, prepay shipping charges, 
and insure the shipment or accept the risk of loss or damage during shipment. 

Limited Warranty Terms for Dell-Branded Hardware Products (Canada Only)

What is covered by this limited warranty?
This limited warranty covers defects in materials and workmanship in your—our end-user customer's—
Dell-branded hardware products, including Dell-branded peripheral products.

What is not covered by this limited warranty?
This limited warranty does not cover:

• Software, including the operating system and software added to the Dell-branded hardware products 
through our factory-integration system, or the reloading of the software

• Non-Dell branded and Solution Provider Direct products and accessories

• Problems that result from:

– External causes such as accident, abuse, misuse, or problems with electrical power

– Servicing not authorized by Dell

– Usage that is not in accordance with product instructions

– Failure to follow the product instructions or failure to perform preventive maintenance 

– Problems caused by using accessories, parts, or components not supplied by Dell

• Products with missing or altered service tags or serial numbers

• Products for which we have not received payment
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THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS 
WHICH VARY FROM PROVINCE TO PROVINCE. DELL'S RESPONSIBILITY FOR MALFUNCTIONS AND 
DEFECTS IN PRODUCT IS LIMITED TO REPAIR AND REPLACEMENT AS SET FORTH IN THIS 
WARRANTY STATEMENT, FOR THE TERM OF THE WARRANTY PERIOD REFLECTED ON YOUR 
PACKING SLIP OR INVOICE. EXCEPT FOR THE EXPRESS WARRANTIES CONTAINED IN THIS 
WARRANTY STATEMENT, DELL DISCLAIMS ALL OTHER WARRANTIES AND CONDITIONS, EXPRESS 
OR IMPLIED, INCLUDING WITHOUT LIMITATION IMPLIED WARRANTIES AND CONDITIONS OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, STATUTORY OR OTHERWISE. 
SOME PROVINCES DO NOT ALLOW THE EXCLUSION OF CERTAIN IMPLIED WARRANTIES OR 
CONDITIONS, OR LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY OR CONDITION LASTS. 
THEREFORE, THE FOREGOING EXCLUSIONS AND LIMITATIONS MAY NOT APPLY TO YOU. 

WE DO NOT ACCEPT LIABILITY BEYOND THE REMEDIES PROVIDED FOR IN THIS WARRANTY 
STATEMENT OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, 
INCLUDING, WITHOUT LIMITATION, ANY LIABILTY FOR THIRD-PARTY CLAIMS AGAINST YOU FOR 
DAMAGES, FOR PRODUCTS NOT BEING AVAILABLE FOR USE, OR FOR LOST DATA OR LOST 
SOFTWARE. OUR LIABILITY WILL BE NO MORE THAN THE AMOUNT YOU PAID FOR THE PRODUCT 
THAT IS THE SUBJECT OF A CLAIM. THIS IS THE MAXIMUM AMOUNT FOR WHICH WE ARE 
RESPONSIBLE.

SOME PROVINCES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF SPECIAL, INDIRECT, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY 
NOT APPLY TO YOU.

How long does this limited warranty last?
This limited warranty lasts for the time period indicated on your packing slip or invoice, except that the limited 
warranty on Dell-branded batteries lasts only one year and the limited warranty on the lamps for Dell-branded 
projectors lasts only ninety days. The limited warranty begins on the date of the packing slip or invoice. The 
warranty period is not extended if we repair or replace a warranted product or any parts. Dell may change the terms 
and availability of limited warranties, at its discretion, but any changes will not be retroactive (that is, the warranty 
terms in place at the time of purchase will apply to your purchase).
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 What do I do if I need warranty service? 
Before the warranty expires, please call us at the relevant number listed in the following table. Please also have your 
Dell service tag number or order number available.

What will Dell do?
During the 90 days of the 90-day limited warranty and the first year of all other limited warranties: During the 90 
days of the 90-day limited warranty and the first year of all other limited warranties, we will repair any 
Dell-branded hardware products returned to us that prove to be defective in materials or workmanship. If we are 
not able to repair the product, we will replace it with a comparable product that is new or refurbished. 

When you contact us, we will issue a Return Material Authorization Number for you to include with your return. 
You must return the products to us in their original or equivalent packaging, prepay shipping charges, and insure 
the shipment or accept the risk if the product is lost or damaged in shipment. We will return the repaired or 
replacement products to you. We will pay to ship the repaired or replaced products to you if you use an address in 
Canada. Otherwise, we will ship the product to you freight collect.

If we determine that the problem is not covered under this warranty, we will notify you and inform you of service 
alternatives that are available to you on a fee basis.

NOTE: Before you ship the product(s) to us, make sure to back up the data on the hard drive(s) and any other 
storage device(s) in the product(s). Remove any confidential, proprietary or personal information, removable 
media, such as floppy disks, CDs, or PC Cards. We are not responsible for any of your confidential, proprietary or 
personal information; lost or corrupted data; or damaged or lost removable media. 

During the remaining years following the first year of all limited warranties: We will replace any defective part 
with new or refurbished parts, if we agree that it needs to be replaced. When you contact us, we will require a valid 
credit card number at the time you request a replacement part, but we will not charge you for the replacement part 
as long as you return the original part to us within thirty days after we ship the replacement part to you. If we do 
not receive the original part within thirty days, we will charge to your credit card the then-current standard price for 
that part. 

Individual Home Consumers; Home Office and Small 
Business Customers:

Canada Only

Technical Support and Customer Service 1-800-847-4096

Medium, Large, and Global Commercial Customers; 
Government, Education, and Healthcare Customers; 
and Value Added Resellers (VARs):

Technical Support 1-800-387-5757

Customer Service 1-800-326-9463

Government or Education Customers, or Individual 
Home Consumers who purchased through an 
Employee Purchase Program:

Technical Support 1-800-387-5757

Customer Service 1-800-326-9463 (Extension 8221 for Individual 
Consumers)

Dell-Branded Memory 1-888-363-5150
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We will pay to ship the part to you if you use an address in Canada. Otherwise, we will ship the part freight collect. 
We will also include a prepaid shipping container with each replacement part for your use in returning the replaced 
part to us. 

NOTE: Before you replace parts, make sure to back up the data on the hard drive(s) and any other storage 
device(s) in the product(s). We are not responsible for lost or corrupted data. 

What if I purchased a service contract?
If your service contract is with Dell, service will be provided to you under the terms of the service contract. Please 
refer to that contract for details on how to obtain service. Dell's service contracts can be found online at 
www.dell.ca or by calling Customer Care at 1-800-847-4096. If you purchased through us a service contract with 
one of our third-party service providers, please refer to that contract (mailed to you with your packing slip or 
invoice) for details on how to obtain service. 

How will you fix my product?
We use new and refurbished parts made by various manufacturers in performing warranty repairs and in building 
replacement parts and systems. Refurbished parts and systems are parts or systems that have been returned to Dell, 
some of which were never used by a customer. All parts and systems are inspected and tested for quality. 
Replacement parts and systems are covered for the remaining period of the limited warranty for the product you 
bought. Dell owns all parts removed from repaired products. 

What do I do if I am not satisfied?
We pride ourselves on our great customer service. If you are not satisfied with the service you receive under this 
limited warranty, please let us know. We have found that the best way to resolve issues regarding our limited 
warranty is to work together. If, after those discussions, you are still not satisfied, we believe arbitration is the most 
expeditious way to resolve your concerns. Therefore, ANY CLAIM, DISPUTE, OR CONTROVERSY 
(WHETHER IN CONTRACT, TORT, OR OTHERWISE, WHETHER PREEXISTING, PRESENT OR 
FUTURE, AND INCLUDING STATUTORY, COMMON LAW, INTENTIONAL TORT, AND EQUITABLE 
CLAIMS) AGAINST DELL arising from or relating to this limited warranty, its interpretation, or the breach, 
termination or validity thereof, the relationships which result from this limited warranty (including, to the full 
extent permitted by applicable law, relationships with third parties), Dell's advertising, or any related purchase 
SHALL BE RESOLVED EXCLUSIVELY AND FINALLY BY BINDING ARBITRATION ADMINISTERED 
BY THE NATIONAL ARBITRATION FORUM (NAF) under its Code of Procedure then in effect (available via 
the Internet at www.arb-forum.com/, or via telephone at 1-800-474-2371). The arbitration will be limited solely to 
the dispute or controversy between you and Dell. Any award of the arbitrator(s) shall be final and binding on each 
of the parties, and may be entered as a judgment in any court of competent jurisdiction. Information may be 
obtained and claims may be filed with the NAF at P.O. Box 50191, Minneapolis, MN 55405. 

May I transfer the limited warranty?
Limited warranties on systems may be transferred if the current owner transfers ownership of the system and 
records the transfer with us. The limited warranty on Dell-branded memory may not be transferred. You may 
record your transfer by going to Dell’s website: 

• For Canada-purchased computers (in-country transfers) and to transfer from one customer to another, go to 
www.dell.ca/ca/en/gen/topics/segtopic_ccare_nav_013_ccare.htm

• For out-of-country transfers (outside of the original country of purchase), go to 
www.dell.com/us/en/biz/topics/sbtopic_ccare_nav_016_ccare.htm
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 If you do not have Internet access, call Dell at 1-800-847-4096 (Home Consumer customers) or 1-800-326-9463 
(Corporate Commercial or Government customers).

"Total Satisfaction" Return Policy (Canada Only)
If you are an end-user customer who bought new products directly from Dell, you may return them to Dell up to 
30 days after you receive them for a refund or credit of the product purchase price. If you are an end-user customer 
who bought reconditioned or refurbished products from Dell, you may return them to Dell within 14 days after the 
date on the packing slip or invoice for a refund or credit of the product purchase price. In either case, the refund or 
credit will not include any shipping and handling charges shown on your packing slip or invoice and will be subject 
to a fifteen percent (15%) restocking fee, unless otherwise prohibited by law. If you are an organization that bought 
the products under a written agreement with Dell, the agreement may contain different terms for the return of 
products than specified by this policy. 

To return products, you must call Dell Customer Service at 1-800-847-4096 to receive a Credit Return 
Authorization Number. To expedite the process of your refund or credit, Dell expects you to return the products to 
Dell in their original packaging within five days of the date that Dell issues the Credit Return Authorization 
Number. You must also prepay shipping charges and insure the shipment or accept the risk of loss or damage 
during shipment. You may return software for a refund or credit only if the sealed package containing the floppy 
disk(s) or CD(s) is unopened. Returned products must be in as-new condition, and all of the manuals, floppy 
disk(s), CD(s), power cables, and other items included with a product must be returned with it. For customers who 
want to return, for refund or credit only, either application or operating system software that has been installed by 
Dell, the whole system must be returned, along with any media and documentation that may have been included 
in the original shipment. 

The "Total Satisfaction" Return Policy does not apply to Dell | EMC storage products. It also does not apply to 
products purchased through Dell's Software and Peripherals division. For those products, please instead refer to 
Dell's Software and Peripheral's then-current return policy (see the following section, "Dell Software and 
Peripherals (Canada Only)"). 

Dell Software and Peripherals (Canada Only)

Third-Party Software and Peripherals Products
Similar to other resellers of software and peripherals, Dell does not warrant third-party products. Third-party 
software and peripheral products are covered by the warranties provided by the original manufacturer or publisher 
only. Third-party manufacturer warranties vary from product to product. Consult your product documentation for 
specific warranty information. More information may also be available from the manufacturer or publisher.

While Dell offers a wide selection of software and peripheral products, we do not specifically test or guarantee that 
all of the products we offer work with any or all of the various models of Dell computers, nor do we test or 
guarantee all of the products we sell on the hundreds of different brands of computers available today. If you have 
questions about compatibility, we recommend and encourage you to contact the third-party software and 
peripheral product manufacturer or publisher directly.
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Dell-Branded Peripheral Products
Dell does provide a limited warranty for new Dell-branded peripheral products (products for which Dell is listed as 
the manufacturer) such as monitors, batteries, memory, docking stations, and projectors). To determine which 
limited warranty applies to the product you purchased, see the Dell packing slip or invoice and/or the product 
documentation that accompanied your product. Descriptions of Dell's limited warranties are described in 
preceding sections. 

Return Policy 
If you are an end-user customer who bought Dell Software and Peripherals products directly from a Dell company, 
you may return Dell Software and Peripherals products that are in as-new condition to Dell up to 30 days from the 
date on the packing slip or invoice for a refund of the product purchase price if already paid. This refund will not 
include any shipping and handling charges shown on your packing slip or invoice; you are responsible for those. 

To return products, you must call Dell Customer Service at 1-800-387-5759 to receive a Credit Return 
Authorization Number. You must ship the Dell Software and Peripherals products back to Dell in their original 
manufacturer's packaging (which must be in as-new condition), prepay shipping charges, and insure the shipment 
or accept the risk of loss or damage during shipment. 

To qualify for refund or replacement, returned products must be in as-new condition, software products must be 
unopened, and all of the manuals, floppy disk(s), CD(s), power cables, and other items included with a product 
must be returned with it. 

One-Year End-User Manufacturer Guarantee (Latin America and the 
Caribbean Only)

Guarantee
Dell Computer Corporation ("Dell") warrants to the end user in accordance with the following provisions that its 
branded hardware products, purchased by the end user from a Dell company or an authorized Dell distributor in 
Latin America or the Caribbean, will be free from defects in materials, workmanship, and design affecting normal 
use, for a period of one year from the original purchase date. Products for which proper claims are made will, at 
Dell’s option, be repaired or replaced at Dell’s expense. Dell owns all parts removed from repaired products. Dell 
uses new and reconditioned parts made by various manufacturers in performing repairs and building replacement 
products.

Exclusions
This Guarantee does not apply to defects resulting from: improper or inadequate installation, use, or maintenance; 
actions or modifications by unauthorized third parties or the end user; accidental or willful damage; or normal wear 
and tear.
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 Making a Claim
Claims must be made in Latin America or the Caribbean by contacting the Dell point of sale within the guarantee 
period. The end user must always supply proof of purchase, indicating name and address of the seller, date of 
purchase, model and serial number, name and address of the customer, and details of symptoms and configuration 
at the time of malfunction, including peripherals and software used. Otherwise, Dell may refuse the guarantee 
claim. Upon diagnosis of a warranted defect, Dell will make arrangements and pay for ground freight and insurance 
to and from Dell’s repair/replacement center. The end user must ensure that the defective product is available for 
collection properly packed in original or equally protective packaging together with the details listed above and the 
return number provided to the end user by Dell.

Limitation and Statutory Rights
Dell makes no other warranty, guarantee or like statement other than as explicitly stated above, and this Guarantee 
is given in place of all other guarantees whatsoever, to the fullest extent permitted by law. In the absence of 
applicable legislation, this Guarantee will be the end user’s sole and exclusive remedy against Dell or any of its 
affiliates, and neither Dell nor any of its affiliates shall be liable for loss of profit or contracts, or any other indirect 
or consequential loss arising from negligence, breach of contract, or howsoever. 

This Guarantee does not impair or affect mandatory statutory rights of the end user against and/or any rights 
resulting from other contracts concluded by the end user with Dell and/or any other seller.

Dell World Trade LP
One Dell Way, Round Rock, TX 78682, USA

Dell Computadores do Brasil Ltda (CNPJ No. 72.381.189/0001-10)/
Dell Commercial do Brasil Ltda (CNPJ No. 03 405 822/0001-40)
Avenida Industrial Belgraf, 400
92990-000 - Eldorado do Sul – RS - Brasil

Dell Computer de Chile Ltda
Coyancura 2283, Piso 3- Of.302,
Providencia, Santiago - Chile

Dell Computer de Colombia Corporation
Carrera 7 #115-33 Oficina 603
Bogota, Colombia

Dell Computer de Mexico SA de CV
Paseo de la Reforma 2620 - 11° Piso
Col. Lomas Altas 
11950 México, D.F.
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Dell Computer Corporation 
Ink and Toner Cartridges Limited Warranties
The following sections describe the limited warranty for ink and toner cartridges for the U.S., Canada, and Latin 
America. Refer to the appropriate limited warranty accordingly.

Ink and Toner Cartridges Limited Warranty (U.S. and Canada Only)
Dell Computer Corporation warrants to the original purchaser of genuine Dell-branded toner cartridges that they 
will be free from defects in material and workmanship for the life of the cartridge and that for genuine 
Dell-branded ink cartridges they will be free from defects in material and workmanship for two years beginning on 
the date of invoice. If this product proves defective in either material or workmanship, it will be replaced without 
charge during the limited warranty period if returned to Dell. You must first call our toll-free number to get your 
return authorization. In the U.S., call 1-800-822-8965; in Canada, call 1-800-387-5757. If we are not able to replace 
the product because it has been discontinued or is not available, we will either replace it with a comparable 
product or reimburse you for the cartridge purchase cost, at Dell’s sole option. This limited warranty does not 
apply to ink or toner cartridges that have been refilled or improperly stored or due to problems resulting from 
misuse, abuse, accident, neglect, mishandling, incorrect environments, or wear from ordinary use.

THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS 
WHICH VARY FROM STATE TO STATE (OR JURISDICTION TO JURISDICTION). DELL’S 
RESPONSIBILITY FOR MALFUNCTIONS AND DEFECTS IN HARDWARE IS LIMITED TO 
REPLACEMENT AS SET FORTH IN THIS WARRANTY STATEMENT. FOR CANADIAN CUSTOMERS, 
EXCEPT FOR THE EXPRESS WARRANTIES CONTAINED IN THIS WARRANTY STATEMENT, DELL 
DISCLAIMS ALL OTHER WARRANTIES AND CONDITIONS, EXPRESS OR IMPLIED, STATUTORY OR 
OTHERWISE, FOR THE PRODUCT. FOR U.S. CUSTOMERS, ALL EXPRESS AND IMPLIED 
WARRANTIES FOR THE PRODUCT, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES 
AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
LIMITED IN TIME TO THE TERM OF THIS LIMITED WARRANTY. NO WARRANTIES, WHETHER 
EXPRESS OR IMPLIED, WILL APPLY AFTER THE LIMITED WARRANTY PERIOD HAS EXPIRED. SOME 
STATES OR JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF CERTAIN IMPLIED WARRANTIES 
OR CONDITIONS, OR LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY OR CONDITION 
LASTS, SO THIS LIMITATION MAY NOT APPLY TO YOU. THIS WARRANTY COVERAGE TERMINATES 
IF YOU SELL OR OTHERWISE TRANSFER THIS PRODUCT TO ANOTHER PARTY.

DELL DOES NOT ACCEPT LIABILITY BEYOND THE REMEDIES PROVIDED FOR IN THIS LIMITED 
WARRANTY OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL OR INCIDENTAL DAMAGES, 
INCLUDING, WITHOUT LIMITATION, ANY LIABILTY FOR THIRD-PARTY CLAIMS AGAINST YOU FOR 
DAMAGES, FOR PRODUCTS NOT BEING AVAILABLE FOR USE, OR FOR LOST DATA OR LOST 
SOFTWARE. DELL’S LIABILITY WILL BE NO MORE THAN THE AMOUNT YOU PAID FOR THE 
PRODUCT THAT IS THE SUBJECT OF A CLAIM. THIS IS THE MAXIMUM AMOUNT FOR WHICH DELL 
IS RESPONSIBLE.

SOME STATES OR JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF SPECIAL, 
INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR 
EXCLUSION MAY NOT APPLY TO YOU.
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 Ink and Toner Cartridges Limited Warranty (Latin America Only)
Dell Computer Corporation warrants to the original purchaser of genuine Dell-branded toner cartridges that the 
cartridges will be free from defects resulting from material or manufacturing process for the life of the cartridge. 
For the original purchaser of genuine Dell-branded ink cartridges, Dell warrants that the cartridges will be free 
from defects resulting from material or manufacturing process for one year beginning from the date of delivery.

If this product presents defects resulting from either material or manufacturing process, it will be replaced without 
charge during the limited warranty period if returned to Dell.

In order to obtain the necessary information to enable the replacement, call the appropriate toll-free number. In 
Mexico, call 001-877-533-6230; in Puerto Rico, call 1-877-839-5123. In cases in which either the production of the 
cartridge has been discontinued or the cartridge is not available, Dell reserves the right, at its sole discretion, to 
choose between replacing it by a similar product or reimbursing you for the purchase cost.

This limited warranty does not apply to ink or toner cartridges that have been refilled or to defects resulting from 
misuse, abuse, accident, negligence, mishandling, improper storage or exposure to inappropriate environments.

Dell’s liability for the malfunction or defect of hardware after the period of the legal warranty (and specifically the 
period of the legal warranty of defective products stated in the consumer protections rules), is limited to either the 
substitution of the product or the reimbursement as stated above. This warranty coverage terminates if you sell or 
otherwise transfer this product to a third party. 

Dell does not accept any additional liability for patrimonial, emotional or any other kind of damage caused to the 
consumer and/or to a third party, which exceeds the established liability either in this limited warranty or in legal 
rules that may apply.
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Dell Software License Agreement
This is a legal agreement between you, the user, and Dell Products, L.P ("Dell"). This 
agreement covers all software that is distributed with the Dell product, for which there is no 
separate license agreement between you and the manufacturer or owner of the software 
(collectively the "Software"). By opening or breaking the seal on the Software packet(s), 
installing or downloading the Software, or using the Software that has been preloaded or is 
embedded in your computer, you agree to be bound by the terms of this agreement. If you 
do not agree to these terms, promptly return all Software items (disks, written materials, 
and packaging) and delete any preloaded or embedded Software. 

You may use one copy of the Software on only one computer at a time. If you have multiple 
licenses for the Software, you may use as many copies at any time as you have licenses. "Use" 
means loading the Software in temporary memory or permanent storage on the computer. 
Installation on a network server solely for distribution to other computers is not "use" if (but 
only if) you have a separate license for each computer to which the Software is distributed. 
You must ensure that the number of persons using the Software installed on a network 
server does not exceed the number of licenses that you have. If the number of users of 
Software installed on a network server will exceed the number of licenses, you must 
purchase additional licenses until the number of licenses equals the number of users before 
allowing additional users to use the Software. If you are a commercial customer of Dell or a 
Dell affiliate, you hereby grant Dell, or an agent selected by Dell, the right to perform an 
audit of your use of the Software during normal business hours, you agree to cooperate with 
Dell in such audit, and you agree to provide Dell with all records reasonably related to your 
use of the Software. The audit will be limited to verification of your compliance with the 
terms of this agreement. 

The Software is protected by United States copyright laws and international treaties. You 
may make one copy of the Software solely for backup or archival purposes or transfer it to a 
single hard disk provided you keep the original solely for backup or archival purposes. You 
may not rent or lease the Software or copy the written materials accompanying the 
Software, but you may transfer the Software and all accompanying materials on a 
permanent basis if you retain no copies and the recipient agrees to the terms hereof. Any 
transfer must include the most recent update and all prior versions. You may not reverse 
engineer, decompile or disassemble the Software. If the package accompanying your 
computer contains compact discs, 3.5" and/or 5.25" disks, you may use only the disks 
appropriate for your computer. You may not use the disks on another computer or network, 
or loan, rent, lease, or transfer them to another user except as permitted by this agreement.
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 Limited Warranty
Dell warrants that the Software disks will be free from defects in materials and 
workmanship under normal use for ninety (90) days from the date you receive them. This 
warranty is limited to you and is not transferable. Any implied warranties are limited to 
ninety (90) days from the date you receive the Software. Some jurisdictions do not allow 
limits on the duration of an implied warranty, so this limitation may not apply to you. The 
entire liability of Dell and its suppliers, and your exclusive remedy, shall be (a) return of the 
price paid for the Software or (b) replacement of any disk not meeting this warranty that is 
sent with a return authorization number to Dell, at your cost and risk. This limited warranty 
is void if any disk damage has resulted from accident, abuse, misapplication, or service or 
modification by someone other than Dell. Any replacement disk is warranted for the 
remaining original warranty period or thirty (30) days, whichever is longer. 

Dell does NOT warrant that the functions of the Software will meet your requirements or 
that operation of the Software will be uninterrupted or error free. You assume responsibility 
for selecting the Software to achieve your intended results and for the use and results 
obtained from the Software.

DELL, ON BEHALF OF ITSELF AND ITS SUPPLIERS, DISCLAIMS ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE, FOR THE SOFTWARE AND ALL ACCOMPANYING 
WRITTEN MATERIALS. This limited warranty gives you specific legal rights; you may 
have others, which vary from jurisdiction to jurisdiction.

IN NO EVENT SHALL DELL OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES 
WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF 
BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS 
INFORMATION, OR OTHER PECUNIARY LOSS) ARISING OUT OF USE OR 
INABILITY TO USE THE SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. Because some jurisdictions do not allow an exclusion or limitation of 
liability for consequential or incidental damages, the above limitation may not apply to you.
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U.S. Government Restricted Rights
The software and documentation are "commercial items" as that term is defined at 48 
C.F.R. 2.101, consisting of "commercial computer software" and "commercial computer 
software documentation" as such terms are used in 48 C.F.R. 12.212. Consistent with 48 
C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through 227.7202-4, all U.S. Government end users 
acquire the software and documentation with only those rights set forth herein. 
Contractor/manufacturer is Dell Products, L.P., One Dell Way, Round Rock, Texas 78682.

General
This license is effective until terminated. It will terminate upon the conditions set forth 
above or if you fail to comply with any of its terms. Upon termination, you agree that the 
Software and accompanying materials, and all copies thereof, will be destroyed. This 
agreement is governed by the laws of the State of Texas. Each provision of this agreement is 
severable. If a provision is found to be unenforceable, this finding does not affect the 
enforceability of the remaining provisions, terms, or conditions of this agreement. This 
agreement is binding on successors and assigns. Dell agrees and you agree to waive, to the 
maximum extent permitted by law, any right to a jury trial with respect to the Software or 
this agreement. Because this waiver may not be effective in some jurisdictions, this waiver 
may not apply to you. You acknowledge that you have read this agreement, that you 
understand it, that you agree to be bound by its terms, and that this is the complete and 
exclusive statement of the agreement between you and Dell regarding the Software.
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Index

A
Advanced tab, 9

aligning ink cartridges, 31

All-In-One Center, see Dell 
All-In-One Center

All-In-One Main page
Copy section, 5
Creative Tasks section, 5
Preview section, 5
Scan section, 4

B
banner paper, 13

banners, printing, 7

black and white, printing in, 7

both sides, printing on, see 
duplexing

C
cards

loading, 13

cartridges
aligning, 31
cleaning, 32
removing, 30
replacing, 30

viewing ink levels of, 8

cleaning, ink cartridge 
nozzles, 32

Contact Information tab, 9

copies, 7

copy settings, 5

copying, 17

custom size paper
loading, 13

D
Dell All-In-One Center, 4

accessing, 4

Dell Printer Solution 
Center, 8

accessing, 8
Advanced tab, 9
Contact Information tab, 9
How To tab, 9
Maintenance tab, 9
Troubleshooting tab, 9

duplexing, 7

E
envelopes

loading, 13

envelopes, printing, 7

F
faxing, 20

G
glossy paper

loading, 13

greeting cards
loading, 13

H
hardware setup, 2

How To tab, 9

I
I Want To

change quality settings, 7
change speed settings, 7
print a banner, 7
print a photo, 7
print a poster, 7
print an envelope, 7
print on both sides of the 

paper, 7
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see more printing ideas, 7

I Want To menu, 7

index cards
loading, 13

ink cartridges
aligning, 31
cleaning, 32
removing, 30
replacing, 30
viewing ink levels of, 8

ink levels, viewing, 8

iron-on transfers
loading, 13
printing, 7

L
loading

cards, 13
custom size paper, 13
envelopes, 13
greeting cards, 13
index cards, 13
iron-on transfers, 13
photo cards, 13
photo paper, 13
postcards, 13
transparencies, 13

loading paper, 16

M
Maintain/Troubleshoot 

page, 6

Maintenance tab, 9

multiple copies, 7

O
operator panel, 2

ordering supplies, ii

orientation, selecting, 7

P
paper

acceptable types of, 16
banner, 13
card stock, 13
cards, 13
custom size, 13
envelopes, 13
iron-on transfers, 13
labels, 13
loading, 16
photo, 13
plain, 13
transparencies, 13

Paper Setup tab, 7

parts of your printer, i

photo cards
loading, 13

photo paper
loading, 13

photos
printing, 7
scanning, 18

postcards
loading, 13

posters, printing, 7

Preview section
Print/Copy preview, 5
Scan preview, 5

Print Layout tab, 7

Print Properties
I Want To menu, 7
Options menu, 8
Paper Setup tab, 7
Print Layout tab, 7
Quality/Copies tab, 7
Save Settings menu, 8
tabs, 7

printing, 16
banners, 7
envelopes, 7
photos, 7
posters, 7

Printing Status window
changing appearance of, 9

Q
Quality/Copies tab, 7

R
removing ink cartridges, 30

replacing ink cartridges, 30

S
safety information, iv

Save Settings menu, 8

saved images, viewing, 5
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scan settings, 4

scanning, 18
placing document, 15

settings, saving for future 
use, 8

setup, 2

software setup, 2

specialty papers
banner, 13
cards, 13
custom size paper, 13
envelopes, 13
greeting cards, 13
index cards, 13
iron-on transfers, 13
photo cards, 13
photo paper, 13
postcards, 13
transparencies, 13

supplies, ordering, ii

T
toner, ordering, ii

transparencies
loading, 13

troubleshooting
setup problems, 34

Troubleshooting tab, 9

V
View Saved Images page, 5

Open with... section, 5
Print a Copy... section, 5

W
warranty, 52
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